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Reflection for Secure IT Web Edition 

 

Introduction 

Reflection for Secure IT Web Edition provides a secure way to manage file exchange with users 
outside your network. A typical configuration is shown here: 

 

  

This configuration has three components.  

 The external user workstation 

Users connect to the web-based Reflection for Secure IT Transfer Client using a URL you 
have provided. With this client, users can upload or download documents using an easy 
drag-and-drop interface.  

 The gateway server 

The Reflection for Secure IT server running in the DMZ authenticates the external user and 
manages document transfers. You can configure this server to access documents on an 
additional server (the document depot) running within your network. Data streams 
continuously through the gateway, eliminating the need to save the file on this server. This 
is more secure and more efficient than file transfer solutions that require the file to be 
stored and then forwarded.  

Additional Web Edition software installed on this server includes the application server for 
the Transfer Client and the web-based User Manager for managing external users.  

 The document depot 

This internal server is the ultimate destination for uploaded files and the source for 
downloads. The external user sees only virtual directories that you have configured, and has 
no knowledge of the actual host name or the physical directory names on this server. 

Secure authentication and encryption are used for each connection in this configuration. 
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Installation and Setup 

In this Chapter 

Web Edition Services 5 

Web Edition Server Requirements 5 

Transfer Client requirements 6 

Install Web Edition on the Gateway Server 7 

Configure the Document Depot 8 

 

 

Web Edition Services 

Reflection for Secure IT Web Edition installs three services: 

 Attachmate Reflection for Secure IT User Manager 

Manages which users can log onto the Reflection for Secure IT server and enables 
administrators to configure group membership to support customized file access. 

 Attachmate Reflection for Secure IT Server 

Authenticates users and manages secure file transfers. You can configure access to 
directories on this server or on additional hosts, and configure virtual directory names to 
represent actual directories on these servers. You can also configure user or group 
subconfigurations to customize transfer rights. 

 Attachmate Reflection for Secure IT Web Server 

An application server that provides the Reflection for Secure IT Transfer Client. The 
Transfer Client is a Java applet that runs in the end user's web browser. This drag-and-drop 
transfer utility enables users to transfer documents between their local system and the 
virtual directories you have made available to them. The Transfer Client service is provided 
by the Reflection for Secure IT Web Server. 

 

Web Edition Server Requirements 

Reflection for Secure IT Web Edition is supported on the following platforms 

 Windows Server 2008 (x86, x64) 

 Windows Server 2008 R2 (x64) 

 VMWare (running supported platforms) 

C H A P T E R  1  
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The User Manager is a web-based application. It has been tested on the following web 
browsers. JavaScript and cookies must be enabled. 

 Microsoft Internet Explorer 8,9 (Windows only) 

 Mozilla Firefox 12 (on Windows), 13 (on Mac) 

 Google Chrome 20 (on Windows and Mac) 

 Apple Safari 5.1.5 (on Mac only) 

Older browser versions are not supported. Attachmate makes every effort to support newer 
versions that were not tested at the time of release, however we cannot guarantee that all newer 
versions will be supported. 

Note: For additional recommendations to help ensure a secure environment on this server, see 
Security Recommendations (page 41). 

 

Transfer Client requirements 

The Reflection for Secure IT Web Edition Transfer Client is a Java applet that runs in a web 
browser. Client workstations must meet these requirements. 

 The Transfer Client has been tested on the following web browsers. JavaScript and cookies 
must be enabled. 

Microsoft Internet Explorer 8,9 (Windows only) 
Mozilla Firefox 12 (on Windows), 13 (on Mac) 
Google Chrome 20 (on Windows and Mac) 
Apple Safari 5.1.5 (on Mac only) 

Older browser versions are not supported. Attachmate makes every effort to support newer 
versions that were not tested at the time of release, however we cannot guarantee that all 
newer versions will be supported. 

 The browser must have Java installed. The client has been tested with JRE 1.6.0_26 and 
JRE 1.7.0_07. Older versions are not supported. Attachmate makes every effort to support 
newer versions that were not tested at the time of release, however we cannot guarantee 
that all newer versions will be supported. 

Users who don't have Java installed will see an error message with information about how 
to download Java when they first try to connect. To avoid these messages, ensure that 
client workstations already have Java installed. Java is available free of charge from the 
Oracle website: 

http://java.com/en/download/ 

For Mac OS X 10.6 and below, Apple's Java comes pre-installed with your Mac OS. 
Updates may happen automatically or by going to www.apple.com/support. For Mac OS X 
10.7 (Lion) and above, Java is not pre-installed. You can get the latest Java 7 from the 
Oracle website. 

  

Note: This guide describes how to manage transfer from user workstations using the Reflection 
for Secure IT Web Edition Transfer Client, but using this client is not a requirement. Users can 
also transfer files to and from the Reflection for Secure IT Web Edition server using a 
Reflection for Secure IT Secure Shell client or other Secure Shell (SSH) client.  
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Install Web Edition on the Gateway Server 

Install Reflection for Secure IT Web Edition on the system that will act as your gateway server. 

Note: You must be logged in as an Administrator to install Reflection for Secure IT Web 
Edition. 

To install Reflection for Secure IT Web Edition from the download site 

1 Click the download link and run the download program. 

2 Select a location for the installer files and click OK. 

The files are extracted to the specified location, and the Attachmate Setup program starts. 

3 (Optional) To personalize the installation, click the User Information tab and enter the 
name, organization, and Volume Purchase Agreement (VPA) number (if you have a VPA). 

Note: VPA numbers are used by customer support to expedite service requests. 

4 (Optional) To change the default installation folder, click the File Location tab. 

5 Click Install Now. 

6 After the installation is complete you'll be prompted to restart Windows.  

Note: The restart is required to complete the installation of the Reflection for Secure IT 
server. It also starts the three services used by Reflection for Secure IT Web Edition.  

To confirm that the Reflection for Secure IT Web Edition services are 
running 

1 Open the Windows Services console (Start > All Programs > Administrative Tools > 
Services). 

2 Confirm that the following services are running. (These services are not started by the 
installer, but are started automatically when you restart Windows.) 

• Attachmate Reflection for Secure IT Server 

• Attachmate Reflection for Secure IT User Manager 

• Attachmate Reflection for Secure IT Web Server 
 

Note: After the Windows services have started, it may take several seconds before the web 
sites provided by these services are accessible. 
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Configure the Document Depot 

The server you use as your document depot can be a UNIX or Windows system. It must be 
running a Secure Shell (SSH) server that includes an SFTP server. You can install one of the 
following Attachmate products, or use other SSH server products. 

 Reflection for Secure IT Server for Windows 

 Reflection for Secure IT Server for UNIX 

To configure connections from the Reflection for Secure IT server to the document depot you 
will need to know the following information about this server: 

 The DNS name or IP address 

 A valid user account 

 The port used for Secure Shell connections. (The default is 22.) 
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Getting Started 

In this Chapter 

Create and Test an External User 9 

Configure a Transfer to the Document Depot 12 

Transfer a File from an External User to the Document Depot 14 

Set Transfer Permissions for an External User Group 15 

 

 

Create and Test an External User 

In these procedures, you'll create a sample external user, and test a transfer to the gateway 
server using this external user's credentials. 

 

Before you begin 

 Install Reflection for Secure IT Web Edition on the gateway server and confirm that the 
services are running (page 7). 

 Select an account on the gateway server to act as the "run as" account for external users. 
External users will run under this account name. You'll need to know the username and 
password for this account. 

Note: To limit the access provided to external users, you should select a user account that 
is not a member of the Administrators group on this computer.  

 Designate a computer to use as a test user workstation. Confirm that Java is installed on 
both the user workstation and the gateway server. You will be running the Transfer Client 
from both of these computers, and Java is required for the client. 

C H A P T E R  2  
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Configure the Reflection for Secure IT server to allow access by external 
users 

1 On the gateway server, start the Reflection for Secure IT server console. (Start > All 
Programs > Attachmate Reflection > Reflection SSH Server Configuration.) 

2 On left panel of the Configuration tab, click External Users. 

3 Enable Allow access to external users. 

4 Click Verify connection to confirm that the Reflection for Secure IT server can 
communicate with the User Manager. 

5 Click Select account. Click Add and enter a user name and password for the user under 
whose account external users will run. Click Test to confirm these credentials, then click 
OK to save this user account to the credential cache. 

6 In the Select Account dialog box, select the user account you just added and click OK to 
set this as the account to use for external user access.  

7 (Recommended) To help ensure security on this system, disable port forwarding for all 
users. On the left panel of the Configuration tab, click Permissions. Under Tunneling, 
clear the two port forwarding options.  

8 Save your settings (File > Save Settings). 

  

Launch the User Manager and add a new external user  

1 On the gateway server, start the User Manager. (Start > All Programs > Attachmate 
Reflection > Web Edition User Manager.) 

Note: The User Manager runs in your default browser and you will see a certificate warning 
message before you see the login page. This warning shows up because the User Manager 
installs with a self-signed security certificate which is unknown to your browser. For initial 
testing purposes, you can ignore this warning and proceed with the connection (Internet 
Explorer or Chrome) or add an exception (Firefox). For more information, see Certificate 
Management (page 28). 

2 For your initial login enter the following credentials.  

Username: admin 

Password: secret 

3 Immediately after your first log in, you'll be prompted to change the password for the 
admin account. Enter the current and new password and click Submit. 

Once you are successfully logged in, you should see the Users page. The initial view shows 
a single user - the admin account you used to log in. 

4 From the Users page, click New. 
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5 From the New User page, specify values for your test user's user ID, password, first name, 
last name and email address. Leave group membership unchanged for this test user; group 
configuration is optional.  

Make a note of the user name and password. You'll use these credentials for your next test. 

6 Click Save. 

You'll be returned to the Users page and should see your new user added to the list. 

  

In this next procedure, a test transfer copies a document from one file location on the gateway 
server to another location on the same computer. This test scenario helps confirm that your 
setup is correct.  

Test a transfer on the gateway server 

1 On the gateway server, start the Transfer Client. (Start > All Programs > Attachmate 
Reflection > Web Edition Transfer Client.) 

Note: The Transfer Client runs in your default browser and you will see a certificate warning 
message before you see the log in page. This warning shows up because the Transfer Client 
web server installs with a self-signed security certificate which is unknown to your browser. 
For initial testing purposes, you can ignore this warning and subsequent certificate 
warnings. Before you deploy to actual users, you will need to install a certificate from a 
well-known Certificate Authority (CA). Once you've configured the Reflection for Secure IT 
Web Server to use the CA-signed certificate, users will be able to log in without seeing 
certificate warnings. For more information, see Certificate Management (page 28). 

  

2 Log in using the user ID and password of the external user you just created. 

You'll see two additional messages, a certificate warning followed by a Java query. Both 
messages give you the option to trust content from this publisher, and, if you select this 
option, the messages won't appear again. (The certificate warning won't appear at all once 
you've configured the server to use a CA-signed certificate.) 

3 The Transfer Client opens and connects to the running Reflection for Secure IT server. 
Check to confirm that the status line in the lower left corner says "Connected to server." 

4 Browse to locate a document for a test transfer and drag this file from Local files to Server 
files. After the transfer is complete, you should see the transferred file in the Server files 
list. 

Locate an uploaded file on the gateway server 

1 Find the file you just transferred file on the gateway host in the following location: 

C:\Users\<run_as_user>\ReflectionExternalUsers\Reflection.VirtualDirec
tory\<external_user> 

Where <run_as_user> is the user account you selected for external users to run under 
and <external_user> is the user ID you specified in the User Manager.  
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Note: In this case, the transferred document is saved to the Reflection for Secure IT Web 
Edition server. See Transfer a File from an External User to the Document Depot (page 14) to 
configure a transfer in which the transferred document is saved to a different server. 

Test a transfer from a second computer to the gateway server 

1 To test a transfer from a user workstation, open a browser on a second computer. 

2 Enter the following URL, replacing <gateway_host> with the name or IP address of your 
server: 

https://<gateway_host>:9492/ 

3 Log in using your external user credentials and try a test transfer as described above for 
transferring from the gateway server. 

 

Configure a Transfer to the Document Depot 

In this procedure, you'll configure the Reflection for Secure IT server running on the gateway to 
manage transfers to and from the document depot. 

 

Before you begin 

 Confirm that a Secure Shell server is installed and running on the host that will serve as 
your document depot and that SFTP is enabled. (SFTP is enabled by default on Reflection 
for Secure IT servers.) 

 Confirm the DNS name or IP address for this host and know the port being used for Secure 
Shell connections (22 is the default). 

 Confirm the name and password of a valid account on this host. This user account will 
provide access to file system on the document depot.  

  

To configure transfers to and from a directory on the document depot 

1 On the gateway server, start the Reflection for Secure IT server console. (Start > All 
Programs > Attachmate Reflection > Reflection SSH Server Configuration.) 

2 From the Configuration tab, click SFTP Directories in the left panel, then and click Add. 

3 For Virtual directory, enter Test. This is the directory name that users will see when they 
run the Transfer Client. 
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4 Select Remote SFTP server. This opens the Remote SFTP Server Connection dialog box. 

Note: The "Remote SFTP server" you configure here is your document depot. 

5 For Host, specify the name or IP address of the host that will serve as your document 
depot. The port for the connection to this server is set to 22 by default. Edit this if your 
Secure Shell server uses a different port. 

6 Under Host key, click Retrieve. Reflection for Secure IT connects to the Secure Shell 
server running on the document depot, retrieves the host public key and displays a 
confirmation box. Click OK to accept this key and then close the Get Public Key dialog 
box. 

This key is used to confirm the host identity in subsequent connections, ensuring that 
documents are transferred to the correct host. 

7 Under Authentication, for Remote SFTP username and Password, enter the credentials 
of the user account that will provide access to the file system on the document depot. 

8 Under Remote base directory, click Browse. This opens a browse dialog box showing 
directories available to the user you specified. (The directories available depend on this 
user's privileges and on how the SFTP server is configured.) Browse to select the directory 
you want to make available to your external user and click OK. The directory you select is 
entered in the Path field. 

9 Click Test Connection. You should see a message saying that the connection was 
successful. 

Note: The Test Connection dialog box includes a Details button. You can use the 
information provided to troubleshoot. 

10 Close the dialog boxes and return to the SFTP Directories pane. 

11 In the SFTP Directories pane: 

• Set the User login directory to the virtual directory you just created, for example 
/Test. You'll see a warning message about changing the user key directory. Because 
you are using password authentication and not user keys, this is not a concern and you 
can click Yes to proceed.  

• Disable the default Home directory by clearing the Allow checkbox. 

12 Save your settings (File > Save Settings). 
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Transfer a File from an External User to the 
Document Depot 

This transfer takes your test file from the user workstation to the document depot. 

Before you begin 

 Create and test an external user account (page 9). 

 Configure Reflection for Secure IT to transfer files to a directory on the document depot 
(page 12). 

To test a transfer from the user workstation to the document depot 

1 Open a browser on the computer you designated to act as a user workstation. 

2 Enter the following URL, replacing <gateway_host> with the name or IP address of your 
Reflection for Secure IT Web Edition server: 

https://<gateway_host>:9492/ 

• You will see a certificate warning message before you see the log in page. This warning 
shows up because the Transfer Client installs with a self-signed security certificate 
which is unknown to your browser. For initial testing purposes, you can ignore this 
warning and subsequent certificate warnings. Before you deploy to actual users, you 
will need to install a certificate from a well-known Certificate Authority (CA). Once the 
CA-signed certificate is installed, users will be able to log in without seeing certificate 
warnings. For more information, see Certificate Management (page 28). 

• If you are already logged into the Transfer Client from a previous test, you can click 
Logout, then log in again to test changes you've made on the Reflection for Secure IT 
Web Edition server. 

3 Log in using the username and password or your test user. 

4 On the server side, you should see the files in the Test directory. (This is the Remote base 
directory you configured using the Remote SFTP Server Connection dialog box. The 
contents of this directory are displayed when the user connects because you set it as the 
User Log in directory in the SFTP Directories pane.) 

5 Test an upload to the server from the client computer.  

To confirm that the upload worked, log into your document depot using the credentials you 
specified for connections to this remote server and confirm that the document is present in the 
location you specified for Remote base directory in the Reflection for Secure IT server's 
Remote SFTP Server Connection dialog box. 
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Set Transfer Permissions for an External User 
Group 

You can create customized transfer settings for individual external users and for external user 
groups. In this procedure you'll modify your Reflection for Secure IT server settings to allow 
additional file access to members of the default "Administrators" external user group.  

Before you begin 

 Configure a transfer from an external user to the document depot (page 14). 

Create a group subconfiguration for members of the external users 
Administrators group 

1 On the gateway server, start the Reflection for Secure IT server console. (Start > All 
Programs > Attachmate Reflection > Reflection SSH Server Configuration.) 

2 On the left panel, under Subconfiguration, click Group Configuration. 

3 Click Add. This opens the Group Configuration dialog box. 

4 Set Group type to Domain. 

5 For Domain, enter Reflection.VirtualDirectory.  

Reflection for Secure IT uses this domain name for external users and groups. 

6 For Group, enter Administrators. 

The Administrators group is the only default group in the User Manager, and the default 
admin user is a member of this group. This procedure uses this default group for testing. 
Once you have finished testing, you'll want to configure your own groups and group 
members in the User Manager. 

7 In the left portion of the Group Configuration dialog box, click SFTP Directories. 

8 Click Add. This opens the Accessible Directory Settings dialog box. You'll use it to add 
access to a new folder that will be accessible to members of the Administrators group. 

• For Virtual Directory, enter AdminTest. 

• Click Browse and select any available local folder. It will be entered into Local or 
UNC directory. (For example C:\Test.) 

• Click OK. 

9 Change User login directory to /. (You have added a second accessible directory and this 
change means that users in this subconfiguration will see all available directories when 
they log in.) 

You'll see a warning about changing the user key directory. Because you are using 
password authentication for users, the warning doesn't apply to this test and you can click 
Yes to proceed. 
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10 Click OK to close the Group Configuration dialog box. 

11 Save your settings (File > Save Settings). 

Connect to the Transfer Client as a member of the Administrators group 

1 From the user workstation, log onto the Transfer Client using the default admin account.  

2 The Server file list shows two directories. The first directory (Test) is the directory on the 
document depot that you made available to all users. The second directory (AdminTest) is 
the directory on the Web Edition server that you made available to members of the 
Administrators group.  

 

Note: If you've followed the procedures in this guide, these directories are on two different 
servers. Test is on the document depot and AdminTest is on the Web Edition server. 
These actual server locations are not apparent to the external user. 

3 Log out of the Transfer Client and log in again using your test user credentials to confirm 
that this user logs directly into the Test directory. You can browse up to the parent 
directory and confirm that this user has no view of the AdminTest directory. 
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User Manager Administration 

In this Chapter 

Connect to the User Manager 17 

Adding External Users 18 

Start and Stop the User Manager Server 18 

User Manager Properties File 18 

Reset the User Manager Server to All Defaults 19 

 

 

By default the Reflection for Secure IT server allows access only to users of the local machine 
and users who are members of the same Windows domain. 

The Reflection for Secure IT Web Edition User Manager enables you to provide access to 
additional external users, for example, customers and business partners who need to upload or 
download documents. 

 

 

Connect to the User Manager 

The Reflection for Secure IT Web Edition User Manager is a web-based application. You can 
connect to it from the Windows Start menu or from a browser running on any system with 
access to your Web Edition Server. 

To connect from the Windows Start menu 

 Go to Start > All Programs > Attachmate Reflection > Web Edition User Manager. 

To connect from a browser 

 Enter the following URL, replacing <host> with the DNS name or IP address of your Web 
Edition host. 

https://<host>:9490 

  

Initial Login 

The first time you connect, you need to log in as "admin" (the default administrator account) 
using the password "secret". Immediately after making this connection, you will be prompted to 
modify the admin user's password.  

C H A P T E R  3  



Reflection for Secure IT Web Edition 

18 
 

 

Adding External Users 

By default, the Reflection for Secure IT server allows users to log in only if they are members of 
the same Windows domain as the server or are local users on that server. To provide external 
users with access to files in your network: 

1 Configure the Reflection for Secure IT server to allow access to these external users.  

2 Use the Web Edition User Manager to add, edit, and delete external users.  

For detailed instructions, see Create and Test an External User (page 9).  

 

Start and Stop the User Manager Server 

The User Manager Server starts by default when you restart Windows. You can also use the 
Windows Services console to start and stop this service: 

To start or stop the User Manager service 

1 Open the Windows Services console (Start > All Programs > Administrative Tools > 
Services). 

2 Locate the service called "Attachmate Reflection for Secure IT User Manager." 

 

User Manager Properties File 

You can use the User Manager properties file to modify the following settings: 

 The HTTPS port used to connect to the User Manager. The default is 9490. 

 The port used by the Reflection for Secure IT server and the Reflection for Secure IT Web 
Service to communicate with the User Manager. This value must match the value 
configured in the Web Server properties file and in the External Users pane of the 
Reflection for Secure IT server console. By default, 9190 is configured for all three servers. 

 HTTPS certificate settings. (For more information about these settings, see Replace the 
Default Server Certificate (page 29). 

The properties file is located in the Web Edition installation folder in the WebServer\conf 
subfolder. The default is: 

C:\Program Files\Attachmate\RSecureWebEdition\WebServer\conf\container.pr
operties 
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Notes: 

 You must restart the server (page 26) after editing container.properties for your 
changes to take effect. 

 Paths in this file must be specified using forward slashes or escaped backslashes. For 
example: 

C:/pathto/keystore 

C:\\pathto\\keystore 

 Do not edit the entries at the top of the file (above the first comment). 

 A backup file, container.properties.example, in the same folder provides a copy of 
the original default settings. 

 

 

Reset the User Manager Server to All Defaults 

The User Manager installs a reset batch file that you can use to reset the User Manager and all 
user data to the original shipping state. Running this batch file has the following effects: 

 Restores the original "admin" user with the default password "secret." 

 Deletes all user data 
  

Caution: Resetting the User Manager removes all user data. Use this option only to clear the 
data after testing or if you cannot access the server with any available credentials and 
understand that existing data will be lost. 

To reset the User Manager and user database to the original state 

1 Navigate to UserManager\bin in the Web Edition installation folder. The default location 
is: 

C:\Program Files\Attachmate\RSecureWebEdition\UserManager\bin 

2 Double-click the reset file: 

resetserver.bat 

A command window opens and you'll see a prompt asking if you want to reset the User 
Manager to its initial state. 

3 Press Y.  

4 Start the User Manager server. (page 18) 

5 Connect to the User Manager and log in using "admin" and "secret". You'll be prompted to 
change your password. 
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Reflection for Secure IT Server Configuration 

In this Chapter 

Configure Access to Files and Directories 20 

Set File Upload and Download Permissions 22 

Customize Group and User Settings 23 

Set up File Transfer Auditing 24 

 

Note: The topics that follow describe settings that are relevant to Web Edition administrators. 
For additional information about administering the Reflection for Secure IT server, refer to the 
server Help. 

 

 

Configure Access to Files and Directories 

The Transfer Client shows a Local files list on the left and a Server files list on the right. You 
can use the Reflection for Secure IT server to customize which directories appear in the Server 
files list.  

Note: By default, the same files and directories are available to all users. You can use 
subconfigurations (page 23) to provide different access to specific users or groups of users. 

Local directories 

The Transfer Client's Local files list shows the contents of the user's profile folder. The user 
can browse from this location to any other folders and drives available to this user.  

The user profile folder is configurable by the Windows system administrator. The default is: 

 Windows 7, Windows Server 2008: 
\Users\username\   

 Windows Server 2003: 
\Documents and Settings\username\   

C H A P T E R  4  
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Server directories 

If you have made no modifications to the default SFTP directories settings in Reflection for 
Secure IT, the Server files list shows the contents of a directory called "Home." For external 
users, this virtual directory corresponds to the following physical directory on the server:  

C:\Users\<run_as_user>\ReflectionExternalUsers\Reflection.VirtualDirector
y\<external_user> 

where <run_as_user> is the External user access account (specified on the External Users 
pane in the Reflection for Secure IT server), and <external_user> is the user's UserID 
(added in the User Manager).  

You can use Reflection for Secure IT to customize the server list so that it shows additional 
local directories, directories on one or more remote servers, or a combination. 

To configure access to local directories 

1 Start the Reflection for Secure IT console (Attachmate Reflection > Reflection SSH 
Server Configuration). 

2 From the Configuration tab, click SFTP Directories in the left-hand panel. 

3 Click Add and use the Accessible Directories Settings dialog box to specify the virtual 
directory name and the actual directory path. 

Notes: 

 The directories available to external users are limited by the rights of the user you specify 
for External user access account when you enable external user access.  

 Users have access only to directories that you explicitly make available. They do not have 
access to other directories, even if these directories are available to the External user 
access account. 

 

The following pattern strings are available for configuring the Local or UNC directory. The 
resulting paths for external users are shown here:  

%D Default Home folder. For external users this is: 

C:\Users\<run_as_user>\ReflectionExternalUsers\Reflection.VirtualDirectory\<e
xternal_user> 

This directory is created the first time a user logs into the Reflection for Secure IT server if it 
doesn't already exist. 

%H For external users, this is equivalent to %D. 

%u The external user's UserID. This directory must already exist. 

Caution: If you configure both domain and external users, do not use %u. If an external UserID 
matches a domain username, both users will have access to the same location. In this case, use %U 
to ensure unique pathnames. 
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%U The external user domain name and UserID in the format "domain.username". This directory must 
already exist. 

For external users the domain = Reflection.VirtualDirectory. For example, for the external 
user whose UserID is "Mary", c:\upload\%U resolves to: 

C:\upload\Reflection.VirtualDirectory.Mary 

To configure access to directories on a remote server 

1 On the Windows Start menu, click Attachmate Reflection > Reflection SSH Server 
Configuration. 

2 From the Configuration tab, click SFTP Directories in the left-hand panel. 

3 Click Add and specify a Virtual directory name. 

4 Click Remote SFTP server. 

5 Specify a Host name, retrieve the host key, and enter a username with access to this server 
for Remote SFTP username, and provide authentication information for this user. 

6 In the Path field, enter a path on the server that the user has access to, or use Browse to 
have an available path entered for you.   

Notes: 

 The directories available on the remote server are limited by the rights of the user you 
specify for Remote SFTP username. You cannot provide access to files that are not 
available to this user. 

 Users have access only to directories that you explicitly make available. They do not have 
access to other directories on the remote server, even if these directories are available to 
the specified Remote SFTP username. 

 The %u and %U options described above are supported on remote servers. 

 For additional information, see Configure a Transfer to the Document Depot (page 12) or 
refer to the Reflection for Secure IT server Help. 

 

 

Set File Upload and Download Permissions 

In addition to configuring which files users have access to, you can also set permissions that 
determine what users can do with files. 

Note: You can set different permissions for each virtual directory. By default these permissions 
apply to all users. You can use subconfigurations (page 23) to provide different permissions to 
specific users or groups of users. 
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To set file action permissions 

1 On the Windows Start menu, click Attachmate Reflection > Reflection SSH Server 
Configuration. 

2 On the left panel of the Configuration tab, click SFTP Directories. 

3 Click Add to create a new directory, or select an existing directory and click Edit. 

4 Under Permissions, configure the access you want to allow. For example, to allow users to 
view and download files, but disallow any changes to the server files, leave Browse and 
Download checked, and clear Upload, Delete, and Rename. 

5 Save your settings (File > Save Settings). 

The following permission options are available: 

 Browse View file and directory lists. 

 Download View file contents. 

 Upload Modify files, create files, create directories, and modify file attributes. 

 Delete Delete files and directories. 

 Rename Rename files and directories. 

 

 

Customize Group and User Settings 

The Reflection for Secure IT server supports the ability to customize user- and group-specific 
options. These include the ability to apply subconfigurations and to control access to the 
server. These features are supported for external users that you have added using the Web 
Edition User Manager. To make customizations for external users, you need to configure the 
user or group you are configuring as a member of a domain called "Reflection.VirtualDirectory". 
The general procedure is outline below. For a specific example, see Set Transfer Permissions 
for an External User Group (page 15). 

To configure a subconfiguration for an external user or group 

1 From the Web Edition User Manager, add the user. If you are configuring a group 
subconfiguration, add this user to the group. 

2 From the Configuration tab of the Reflection for Secure IT console, click either Group 
Configuration or User Configuration. 

3 For the group or user type, select Domain and enter the following for the domain name: 

Reflection.VirtualDirectory 

4 Enter the name of the user or group you want to customize. 

5 Click any of the available options on the left side of the subconfiguration dialog box to 
configure options that will be applied to the specified user or group. 

6 Click OK to close the open dialog boxes. 

7 Save your settings (File > Save Settings). 
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To control server access for an external user or group 

1 From the Configuration tab of the Reflection for Secure IT console, click either Group 
Access Control or User Access Control. 

2 Click Add and enter the user or group name using the following format, replacing <name> 
with the user or group name. 

Reflection.VirtualDirectory/<name> 

3 Specify the access setting for this user or group (allow or deny). For information about how 
allow and deny settings affect user access, see the Reflection for Secure IT Help topics 
"Controlling Access by User" and "Controlling Access by Group."  

4 Click OK and save your Reflection for Secure IT settings.  

 

Set up File Transfer Auditing 

You can use audit logging to maintain a record of file transfer activity. Audit logging is not 
enabled by default.  

To enable file transfer auditing  

1 Start the Reflection for Secure IT console (Attachmate Reflection > Reflection SSH 
Server Configuration). 

2 Go to Configuration > Logging > Audit Logging. 

3 Select Enable file transfer auditing. 

4 Save your settings (File > Save Settings). 

When audit logging is enabled, Reflection for Secure IT creates a new log each day in the 
specified Audit log directory. Audit logs use this name format: RSSHD-Audit-YYYYMMDD.log, 
where YYYYMMDD indicates the date. 
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Transfer Client Administration 

In this Chapter 

Connect to the Transfer Client 25 

Start and Stop the Transfer Client Web Server 26 

Customize the Look of the Transfer Client Web Pages 26 

The Web Server Properties File 27 

 

 

Connect to the Transfer Client 

The Reflection for Secure IT Web Edition Transfer Client is a web-based application. Access is 
available to any user who has been added using the Web Edition User Manager. 

From the system running the Web Edition servers, you can connect to the Transfer Client from 
the Windows Start menu 

To connect from the Windows Start menu on the Web Edition server 

 Go to Start > All Programs > Attachmate Reflection > Web Edition Transfer Client. 

End users connect to the Transfer Client from a browser running on any system with access to 
your Web Edition Server. 

To connect from a browser 

 Enter the following URL, replacing <host> with the DNS name or IP address of your Web 
Edition host. 

https://<host>:9492 
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Start and Stop the Transfer Client Web Server 

The Reflection for Secure IT Web Server is the application server that provides the Reflection 
for Secure IT Transfer Client.This server starts by default when you restart Windows. You can 
also use the Windows Services console to start and stop this service: 

To start or stop the User Manager service 

1 Open the Windows Services console (Start > All Programs > Administrative Tools > 
Services). 

2 Locate the service called "Attachmate Reflection for Secure IT Web Server." 

 

Customize the Look of the Transfer Client Web 
Pages 

By default, the Transfer Client uses Attachmate Reflection for Secure IT branding. You can 
modify these web pages so that Transfer Client users see a page title and images that identify 
your organization. 

To customize the Transfer Client web pages 

1 Create a folder called custom in the webapps folder: 

<install path>\WebServer\services\webxfer-ui\webapps\custom 

Note: Making changes in this location ensures that your modifications remain in place after 
a server restart or application upgrade. Changes made in other locations, or to the existing 
files, are not guaranteed to remain in place. 

2 Locate the custom-example directory in webapps and copy the contents of this folder 
into your custom folder.  

3 Edit title.html, replacing the sample title "Custom File Transfer" with the page title you 
want displayed in the user's browser. 

4 View the contents of branding.css. This file configures images and related colors. Create 
appropriate images as defined in this file, and replace the sample images provided with 
your images. 

5 Connect to the Transfer Client or refresh the browser display to view the changes. 
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The Web Server Properties File 

You can use the Web Server properties file to modify the following settings: 

 The HTTPS port used to connect to the Transfer Client. The default is 9492. 

 The port used by the Reflection for Secure IT server and the Reflection for Secure IT Web 
Server to communicate with the User Manager. This value must match the value configured 
in the User Manager properties file and in the External Users pane of the Reflection for 
Secure IT server console. By default, 9190 is configured for all three servers. 

 The hostname and port used by the Transfer Client to connect to the Reflection for Secure 
IT server. By default, the computer name and port 22 are used. The port must match the 
value configured on the Network tab of the Reflection for Secure IT server console.  

 HTTPS certificate settings. (For more information about these settings, see Replace the 
Default Server Certificate (page 29).) 

The properties file is located in the Web Edition installation folder in the WebServer\conf 
subfolder. The default is: 

C:\Program Files\Attachmate\RSecureWebEdition\WebServer\conf\container.pr
operties 

 

Notes: 

 You must restart the server (page 26) after editing container.properties for your 
changes to take effect. 

 Paths in this file must be specified using forward slashes or escaped backslashes. For 
example: 

C:/pathto/keystore 

C:\\pathto\\keystore 

 Do not edit the entries at the top of the file (above the first comment). 

 A backup file, container.properties.example, in the same folder provides a copy of 
the original default settings. 
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Certificate Management 

In this Chapter 

Server Certificates 28 

Replace the Default Server Certificate 29 

Using the keytool Utility to Manage Certificates 30 

Add an Untrusted Certificate to your Browser 34 

 

 

Server Certificates 

When you run the User Manager, the browser connects to the Reflection for Secure IT User 
Manager application server. When you run the Transfer Client, the browser connects to the 
Reflection for Secure IT Web Server. In both cases, the connection is made using HTTPS.  

Why you see certificate warning messages 

When an HTTPS connection is established, the browser requests that the server identify itself. 
By default, the Web Edition servers send a self-signed security certificate to the browser for this 
purpose. (A self-signed certificate is signed by the same entity that it certifies.) The browser 
checks the digital signature in this certificate against its list of trusted Certificate Authorities 
(CAs). You see a certificate warning because the signer of the certificate is not in your browser's 
list of trusted CAs. 

Managing certificates 

Depending on where you are in your Web Edition evaluation and configuration process, you may 
use any or all of the following to manage server certificates. 

 Use the default self-signed certificates and ignore the certificate errors. 

This option is appropriate during initial testing. 

 Configure your browser to trust the self-signed certificates. (page 34) 

This option is appropriate during initial testing. You might also choose this as a permanent 
option for the User Manager. 

 Replace the server's self-signed certificate with a certificate from a well-known Certificate 
Authority. (page 29)  

Make this change to the Reflection for Secure IT Web Server before you provide end-users 
with URLs for launching the Transfer Client. This change enables Transfer Client users to 
connect without seeing certificate warning messages. 
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Replace the Default Server Certificate 

Use the following procedure to replace the self-signed certificate that is installed with these 
Web Edition servers: 

 Reflection for Secure IT Web Server 

 Reflection for Secure IT User Manager 

Before you begin 

Obtain a Java keystore (*.jks) file that contains your private key and a certificate signed by a 
Certificate Authority (CA). You can use either of these approaches, described in the topics that 
follow: 

 If you have a PKCS#12 file (*.p12 or *.pfx) provided by the CA, import the PKCS#12 file 
into a Java keystore (page 31). 

-OR- 

 Generate a key pair and keystore (page 31), create a Certificate Signing Request and 
submit it to CA (page 32). Once you have received the signed certificate for your server, 
import the CA-signed certificate into your keystore (page 33). 

To replace the default server certificate 

Note: The paths below are located in the Web Edition installation folder. The default is 
C:\Program Files\Attachmate\RSecureWebEdition. 

1 Move the new Java keystore to the folder that holds the default keystore (or another secure 
location on your server). The default keystore locations are: 

<install path>\WebServer\etc\ 

<install path>\UserManager\etc\ 

2 Locate the container.properties file in the location below for the server you are 
updating. 

<install path>\WebServer\conf\container.properties 

<install path>\UserManager\conf\container.properties 
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3 Open container.properties in a text editor. Remove the comment character (#) from 
the following lines and edit them to point to your keystore and specify your keystore 
password. For example: 

servletengine.ssl.keystore=../etc/newkeystore.jks 
  
servletengine.ssl.keystorepassword=password 
  

Note: The path to the keystore must be specified using forward slashes or escaped 
backslashes. For example: 
C:/pathto/keystore 
C:\\pathto\\keystore 

4 Restart the server you are configuring. See Start and Stop the Transfer Client Web Server 
(page 26) and Start and Stop the User Manager Server (page 18). 

 

Using the keytool Utility to Manage Certificates 

You can use the Java keytool utility to manage certificates. Reflection for Secure IT Web 
Edition installs a copy of the Java JRE, which includes this utility. 

 

The keytool Utility 

The procedures that follow provide use keytool utility. For complete documentation, see the 
Java keytool documentation 
(http://docs.oracle.com/javase/7/docs/technotes/tools/solaris/keytool.html). 

To run the keytool utility 

1 Open a Command Prompt window. (Start > All Programs >Accessories > Command 
Prompt). 

2 Navigate to the folder that contains keytool.exe.  

On 32-bit systems: 

cd "C:\Program Files\Common Files\Attachmate\JRE\1.7.0_05\bin" 

On 64-bit systems: 

cd "C:\Program Files (x86)\Common Files\Attachmate\JRE\1.7.0_05\bin" 

3 To review the available options, enter the following: 

keytool -help 

http://docs.oracle.com/javase/7/docs/technotes/tools/solaris/keytool.html�
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Import a PKCS#12 File into a Java Keystore 

This procedure uses the Java keytool (page 30) utility to create a Java keystore from a 
PKCS#12 file.  

Before you begin 

 You need a PKCS#12 (*.p12 or *.pfx) containing the certificate you want to use for your 
Web Edition server.  

 You need to know the password that protects this file. 

To import a PKCS#12 file into a Java keystore 

1 Use the importkeystore to create a Java keystore (newkeystore.jks in this example). For 
example: 

keytool -importkeystore -v -srckeystore cert_file.p12 -srcstoretype PKCS12 
-destkeystore newkeystore.jks -deststoretype JCEKS 

Note: The keystore type you specify for deststoretype must match the type specified for 
servletengine.ssl.keystoretype in the server's container.properties file. JCEKS 
is specified by default, and is recommended because it uses a stronger encryption for 
protecting the private key. 

2 When prompted, enter the password of the PKCS#12 file, and use the same password for 
the keystore file.  

 

Generate a Key Pair and Keystore 

This procedure uses the Java keytool (page 30) utility to generate a key and save it to a Java 
keystore. 

Note: The CA you use may have specific options required for creating an HTTPS certificate. 
Review the instructions provided by the CA before creating your key pair. 

To generate a new public/private key pair in a Java keystore 

1 Use the -genkeypair option to generate a key and save it to a Java keystore 
(newkeystore.jks in this example). For example: 

keytool -genkeypair -alias webedition -keyalg RSA -keysize 2048 -keystore 
newkeystore.jks -validity 365 
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2 The keytool prompts you to enter a password, and values for the items that make up the 
distinguished name (DN) in the certificate (name = CN, organizational unit = OU, 
organization = O, city or locality = L, state or province = S, two letter country code = C). 
The generated DN will use the value "Unknown" for any fields you don't specify.  

• When you are prompted with “What is your first and last name?" 

You must enter the DNS name that is used to access the Reflection for Secure IT Web 
Edition server (for example webeditionhost.mycompany.com). This value is used as 
the CN (Common Name) in the certificate. If the CN in a certificate doesn't match the 
actual DNS name used to access the server, you'll see a certificate warning when you 
connect to the server. 

• When you are prompted with "What is the two-letter country code for this unit?" 

You must enter a valid two-letter country code (for example US). 

3 When you are prompted for a password for the alias, press Enter to use the same password 
you used for the keystore. 

Note:  

If you use the keytool command as shown above, the utility prompts you to enter values for the 
items that make up the distinguished name (DN) in the certificate. An alternate option is to 
specify this value on the command line using the -dname option. For example: 

keytool -genkeypair -dname "CN=webeditionhost.mycompany.com, O=My Company, C=US" -
alias webedition -keyalg RSA -keysize 2048 -keystore newkeystore.jks -validity 
365 

 

  

 

Create and Submit a Certificate Signing Request 

This procedure uses the Java keytool (page 30) utility to create a Certificate Signing Request 
(CSR) from an existing keystore.  

Before you begin 

 You need to know the keystore name, password, and alias you used when you created the 
keystore (page 31). 

To create and submit a Certificate Signing Request 

1 Use the -certreq option to generate a certificate request. This generates a Certificate 
Signing Request, using the PKCS#10 format. For example: 

keytool -certreq -alias webedition -keystore newkeystore.jks -file 
cert_request.csr 

2 Enter your keystore password when prompted. 

3 You'll see a message saying that the certificate request has been saved to the file you 
specified (cert_request.csr in this example). 
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4 Submit this CSR to your CA. You will need the contents of the CSR file. Open the file in a 
text editor. The contents should include a header and footer with encoded data between 
them. When you submit the request, copy the entire file, including the BEGIN and END 
lines. 

-----BEGIN CERTIFICATE REQUEST----- 

<encoded data> 

-----END CERTIFICATE REQUEST----- 

 

Import the CA Certificate into your Keystore 

This procedure uses the Java keytool (page 30) utility to import the CA-signed certificate into 
your existing keystore. 

Before you begin 

 You need a certificate for your server signed by a Certificate Authority. 

 You need the trusted root CA certificate for the Certificate Authority. 

 You need to know the keystore name, password, and alias you used when you created the 
keystore. (page 31) 

To import the CA certificate into your Java keystore with a CA-signed 
certificate 

1 Use the -importcert option to add the root CA certificate (CAcert.cer in this example) 
to the Java keystore that you generated when you created your private key 
(newkeystore.jks in this example). Use a new alias (cacert in this example); if the alias 
does not point to a key entry, keytool assumes you are adding a trusted certificate entry. 
For example: 

keytool -importcert -alias cacert -file CAcert.cer -keystore 
newkeystore.jks 

Note: Some CAs issue an intermediate certificate along with the main certificate. If this is 
true for your CA, then import these certificates using unique aliases to your keystore.  

2 Use the -importcert option to add the server certificate you received from the CA 
(certnew.cer in this example) to your keystore. Use the alias you provided when you 
generated the keys; if the alias points to a key entry, keytool assumes you are importing a 
certificate reply. For example: 

keytool -importcert -alias webedition -file certnew.cer -keystore 
newkeystore.jks 
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Add an Untrusted Certificate to your Browser 

If you use the default Reflection for Secure IT certificates, you will see a certificate warning 
when you connect to the User Manager and the Transfer Client. Use these procedures to 
remove these warnings. 

Note: The procedures below are appropriate for testing. However, before you deploy the 
Transfer Client to end users, you should configure Reflection for Secure IT to use certificates 
signed by a well-known Certificate Authority. With the updated certificate in place, the 
following procedures are not necessary. 

To add an untrusted certificate in Internet Explorer 

1 When you see a warning that the security certificate was not issued by a trusted certificate 
authority, select Continue to this website. 

This connects you to the web page and displays a certificate error alert in the address bar. 

2 Click the certificate error alert to view the Certificate Error message shown here: 

 

3 Click View Certificates. 

4 On the certificate General tab, click Install Certificate. 

Note: If the Install Certificate button is not visible, you'll need to modify your browser's 
security settings. Go to Tools > Internet Options > Security, then clear Enable Protected 
Mode. You can restore this setting after you've installed the certificate. 

5 In the Install Certificate Wizard, select Place all certificates in the following store. 
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6 Click Browse and select Trusted Root Certification Authorities, then continue through the 
remaining steps to install the certificate. 

 

To add an untrusted certificate in Firefox 

1 When you see a warning that the connection is untrusted, click I understand the Risks. 

2 Click Add Exception. 

3 Leave Permanently store this exception selected and click Confirm Security Exception. 

4 Click OK to close the dialog boxes. 

 

To add an untrusted certificate in Chrome 

1 Save the presented certificate to a file. To do this: 

• Click the the site information icon in the address bar:  

• Click Certificate Information. 

• On the Details tab, click Copy to File. 

2 Open the Windows certificate store: 

• Click the customize button (three bars) in the upper right:  

• Click Settings. 

• Click Show advanced settings. 

• Click Manage certificates. 

3 Import the saved certificate: 

• Click the Trusted Root Certification Authorities tab. 

• Click Import, then continue through the remaining steps to install the certificate. 

 

To add an untrusted certificate in Safari 

1 When you see a warning that Safari can't verify the identity of the website, click Show 
Certificate. 

2 Click the arrow next to Trust to view the options. 

3 Select Always Trust in the drop down list for the option When using this certificate. 

4 Click Continue. 

5 Enter your password to modify your Certificate Trust settings. 
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Transfer Troubleshooting 

The Browser Cannot Display the Web Page 

 Is the required service running? 

On the Web Edition server, go to the Windows Services console (Start > All Programs > 
Administrative Tools > Services). 

• For the Transfer Client, confirm that "Attachmate Reflection for Secure IT Web Server" 
is started. 

• For the User Manager, confirm that "Attachmate Reflection for Secure IT User 
Manager" is started. 

 

Login Fails at the Transfer Client Login Page 
If the login fails at the initial Transfer Client login page, with "The username or password you 
entered is incorrect," confirm that the user is correctly configured in the User Manager. 

 Has the user been added to the User Manager?  

In User Manager, enter the UserId and click Filter UserID to confirm that the user exists in 
the database. 

 If the user exists, is the password correct?  

If the user has forgotten the password, you can edit the user in User Manager to change 
the password. 
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Transfer Client Login Succeeds but the Server 
Connection Fails 
When the initial login to the Transfer Client succeeds, but the connection to the server fails, 
the problem is likely to be a configuration issue in the Reflection for Secure IT server.  

If no dialog box error message is displayed and "Connection failed: <User name>" appears in 
the menu bar to the left of the Logout button: 

 Is the Reflection for Secure IT server running? 

Go to the server's Status pane, or check the Windows Services console (Start > All 
Programs > Administrative Tools > Services). 

If a dialog box appears with the error message "User authentication failed. Exit Code 14": 

 Is support for external users enabled in the Reflection for Secure IT server? 

From the Reflection for Secure IT console, go to External Users. Is Allow access to 
external users enabled? 

 Are the External user access account credentials valid? 

From the External Users pane, click Select account. Select the account name, click Edit, 
then click Test. 

 Are there permissions settings denying login access? 

Check the Permissions pane and the Access Control panes. 

If the Transfer Client fails to load and the browser locks up: 

 Update to the latest version of Java.  

 

Server Connection Succeeds but Transfer Fails 
If you see the error message "File <filename> transfer failed": 

 Have transfer rights have been disabled in the Reflection for Secure IT server?  

In the SFTP Accessible Directories Settings dialog box, look at the Permissions settings. 

If you see the error message "The transfer operation to the host has failed or was canceled. 
Would you like to delete the remote file?": 

 Has upload access been disabled in the SFTP Accessible Directories Settings dialog box 
under Permissions?  

 Does the External user access account have access to the Local or UNC directory 
specified in the SFTP Accessible Directories Settings dialog box? 

 Does the user you specified in the Remote SFTP Server Configuration dialog box for 
Remote SFTP username have rights to the path specified on the remote server? Use the 
Browse button to ensure that you specify an available directory. 

Note: In all of the above cases, no remote file is created, so clicking Yes and No are 
equivalent in response to "Would you like to delete the remote file?  
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If you see the error message "Failed to change to remote directory <directory name>": 

 Does the directory exist?  

Note: If you use %u or %U in a directory path, you must create user directories in advance; 
these directories are not created automatically when the user logs in. 

 Is the password specified for the remote SFTP user correct? Or, if public keys are 
specified, is public key authentication correctly configured? 

 

Managing Text File Line Endings 

File transfers between the Web Edition Transfer Client and the Reflection for Secure IT server 
are always binary. This means that the content of transferred files, including text file line 
endings, is not modified in any way during the transfer. If you are managing text file transfers 
from systems that use different line endings (for example Mac or UNIX files transferred to the 
Windows server), use a text-file conversion utility to modify line endings.  

Text file line ending conversion is configurable for file transfers between the Reflection for 
Secure IT server and a remote SFTP server. Configure this from the Remote SFTP Server 
Connection dialog box using the Options tab. By default, files with txt, htm, html, bat, and 
cmd are transferred as text files. You can modify this list of text file types, and specify which 
line ending convention should be used on the remote server for transferred text files. (The 
default is to determine the correct line ending automatically. Automatic line conversion is 
available if you are connecting to other Reflection for Secure IT servers; it will not work with 
OpenSSH servers.) 

For transfers involving all three systems (the Transfer Client, the Reflection for Secure IT 
server, and a remote SFTP server) where text conversion is configured and working on the 
Reflection for Secure IT server: 

 All files exposed by the Reflection for Secure IT server for download will have Windows line 
endings. 

 The Reflection for Secure IT server expects all uploaded files to have Windows line 
endings. 

 

Log Files 

User Manager and Web Server Logs 

Log files for the User Manager and Web Server logs are created in the logs folders: 

<install path>\UserManager\logs 

<install path>\WebServer\logs 

Logging configuration can be modified using logback.xml or container.conf, depending 
on which log you want to modify. Instructions are provided in these files.  

Note: Edits you make to logback.xml and container.conf need to be repeated each time 
you apply a hotfix or upgrade your Reflection for Secure IT software. 
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The files are located in the conf folders: 

<install path>\UserManager\conf 

<install path>\WebServer\conf 

The following log files are available for both the Web Server and the User Manager: 

server.log 
server.yyyymmdd.log 

The server log includes primary server logging. This file rolls over daily. 
The file called server.log captures log information for the current day. 
By default rolled-over log files include the date in year-month-date format, 
and logs are deleted after three days. Only the first 15 lines of an 
exception are shown.  

To modify the server log settings, use logback.xml. 

 

console.yyyymmdd.log The console log has startup and runtime details. By default console logs 
roll over daily and include the date in year-month-date format. These files 
are not deleted. 

To modify console log rollover, logging levels, and log deletion, use 
container.conf. 

 

debug.log Debug logging is not enabled by default. A debug.log file is created by 
default, but is not used unless you enable debug logging. 

To enable debug logging, edit logback.xml. The lines to edit and for 
instructions for making the change are under LOG SET UP. 

 

The following additional log is available for the User Manager: 

directory.log 

 

The directory log contains logging related to LDAP directory transactions. 
Rollover configuration is the same as the server log, however rolled over 
logs are usually not present. Rollover is triggered when messages are 
written to the log files, and this log is rarely used. 

To modify the directory log settings, use logback.xml.  

 

 

Note: By default, the server log files and debug log files (when debug logging is enabled) roll 
over daily and are deleted after three days. This helps ensure that disk space is not used up by 
large, accumulating log files. If you alter the configuration to keep these files for a longer 
period, you should monitor the files and/or move them to another server to ensure that 
sufficient disk space is always available. 
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Reflection for Secure IT Server Logs 

The Reflection for Secure IT server supports two methods of logging: to the Windows Event 
Viewer and/or to a text log file. To configure logging, use the Reflection for Secure IT console 
(Attachmate Reflection > Reflection SSH Server Configuration). 

Windows Event Viewer Logging to the Event Viewer is enabled by default.  

To view the Event Viewer log from the Reflection for Secure IT console, 
click the toolbar button, or go to View > Event Viewer. 

To modify the Event Viewer log level, go to Configuration > Logging > 
Event logging.  

 

Text file logs Logging to text files is not enabled by default.  

To enable logging to a text file, set the log level, specify a log file directory, 
and configure rollover, go to Configuration > Logging > Debug logging. 

To view the log file from the Reflection for Secure IT console, click the 
toolbar button, or go to View > Event Latest Debug Log File. 
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Security Recommendations 

The following recommendations help minimize threats to the Reflection for Secure IT Web 
Edition server and the data managed by the server. 

 Limit the accounts on the system running Reflection for Secure IT Web Edition to the 
Administrator account and the non-administrative account that you designate as the run-as 
account for external users. 

 Do not join the Reflection for Secure IT Web Edition server to a Windows domain. 

 Do not run non-essential services on the Reflection for Secure IT Web Edition server that 
might provide user access, such as Telnet servers, FTP servers, and SQL servers. 

 Configure a firewall that limits access to ports on the Reflection for Secure IT Web Edition 
server. The default ports that need to be open to the Internet are 22 (Secure Shell 
connections to the Reflection for Secure IT server) and 9492 (HTTPS connections to the 
Transfer Client). 

 In the Reflection for Secure IT server console, on the External Users pane leave Restrict 
external users to file transfer sessions selected. This default setting helps minimize 
external user access to your system. Also, disable port forwarding for all users. To do this, 
clear both port forwarding options on the Permissions pane under Tunneling. 

 

Changing the JRE 

Use the procedures below to configure the Web Server and User Manager to use a different 
Java Runtime Environment (JRE).  

Notes:  

 Each time you upgrade your JRE, you need to apply the unlimited strength policy files to 
the new JRE.  

 Each time you upgrade Reflection for Secure IT Web Edition or apply a hotfix, you need to 
repeat the changes to the properties files. 

 

C H A P T E R  8  
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Apply the Unlimited Strength Jurisdiction Policy Files to your JRE 

1 Download the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy 
Files from Oracle. Uncompress and extract the downloaded file.  

Note: Be sure to download the correct policy files for your version of Java; version 7 
updates(1.7.x) use a different set of files than version 6 (1.6.x) 

2 Locate the following two policy files. 

local_policy.jar 

US_export_policy.jar 

3 Replace the existing limited strength policy files (located in <java-
folder>\lib\security) with the unlimited strength policy files. 

 

Note: You need to repeat this procedure each time you upgrade your JRE. If you use automatic 
updates, JRE updates will continue to use the same default folder (C:\Program 
Files\Java\jre7), and each new version will overwrite any changes you made to the prior 
version. Java Development Kit (JDK) updates, which include the JRE, use a different folder for 
each update (for example C:\Program Files\Java\jdk1.7.0_07). 

Edit the properties files and restart the servers 

1 Locate the configuration properties file (container.conf) for both the User Manager and 
the Web Server: 

<install path>\UserManager\conf\container.conf 

<install path>\WebServer\conf\container.conf 

2 Open each of these files in a text editor and locate the wrapper.java.command parameter. 
Edit this parameter to specify the full path to the java command (without the .exe 
extension) in your JRE. For example: 

wrapper.java.command=C:\Program Files\Java\jre\1.7.0_07\bin\java 

3 Restart both servers. (page 18, page 26) 
 

Note: You need to repeat this procedure each time you upgrade Reflection for Secure IT Web 
Edition or apply a hotfix. 
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